* viverzk

FD836BA-HVF2, FD836BA-HTV,
FD836BA-EHVF2, FD836BA-EHTV fiet oome

User’'s Manual

H.264 « 2MP « 30M IR ¢ P-iris « Smart Stream « Smart IR

Rev. 1.0



Table of Contents

@ Y= T SRR 3
RNV ] To] o T o 115 o] o PR SSOP 4
[ANCT=To == (o Ty ST U T RS URPSPPR 4
[ Tt &= T =T 0 0] o1 (=] 1 £SO 4
Symbols and Statements in thiS DOCUMENT............iiii e 4
L 0}V To= T B =T Tor o] (T o I PRSP 5
Hardware INSTAlAtION..........o et e ettt e ettt e e s e be et e e e e nebe e e e e annneeeae s 6
N[ AT o Ty [ B T=T o] o) 0 1 T=Y o | O PRSP 17
SOftWAre INSTAIALION ......eoiie bbbt e st e e b bt e e rae e e e anb e e e saneeeenee 20
[RN=T=To LV (o TN F T ST PRRP 21
Auto Focus (for Motorized Lens Models ONIY)........ouviiiiiiiiiiiee e seaee e 22

Accessing the NetWOrK Camera ..ot e e e 23
USING WED BIOWSEIS ... .ttt ettt et e e e e e e e e a ettt et ee e e e e e s e e anbeeteeeeeaaeeeeeeaaaannnnnnee 23
USING RTSP PIAYEIS ...ttt ettt e e et e e e e ettt e e e e abe e e e e e s b ee e e e e nnbe e e e e e nbbeeeeeenreeas 26
Using 3GPP-compatible MODIlE DEVICES.........ccuuiiiieiiiiiiie ettt e e e s e e e e s e e e s snseeeesnnnneeeas 27
Using VIVOTEK Recording SOfIWAIE ..........cooiiiiiiiiiiiie et 28

MAIN PAGE. .. e e 29

(@] 1=Y T AT =Y 11T TSSOSO 34

CONFIGUIALION .. e e s s s s 39
System > General SEHINGS ... .eeiiie et e e e 40
System > HOMEPAGE [QYOUL .......ooiiiiiiiiiiiiieie et e et e e e et e e e e e snne e e e e snbeeeeeennneeeeeeanees 42
YY1 (=T Bl 1o o T ST ERR 45
Y (=T el = T = 1= (Y SRR 47
SYSIEM > MAINTENANCE .....coi oot e ettt e e e ettt e e et e e e e e e nbe e e e e e s nbbeeeeeanreeas 48
Yo 1= Rl [ =T TS PUURPRPE 52
1 T=To F= TV o =Y o L PSRRI 66
[ [=To 1= T U o o J O OO TSPPPPPP PP 75
NEtWOrK > GeNeEral SEHINGS ......ooiiiiiiii ettt e e s e e e e st e e e s anan e e e e s annnneeas 76
Network > Streaming ProtOCOIS .......oiiiiiiiiiiie ittt e ettt e e st e e e s sns e e e e sanneeeesansneeaesannneeeas 84
Network > SNMP (Simple Network Management ProtoCol) .............eoiiiiiiiiiii e 93
SECUNTY > USEI @CCOUNTS ...ociiiiiiiieiiiitiee e sttt e e ettt e e sttt e e e st e e e e s stteee e s e ssaeeeeaansbeeee e nseeeeeeannteeaeeannnseneesannes 94
Security > HTTPS (Hypertext Transfer Protocol over SSL) oo 95
SECUNLY > ACCESS LIST ..oeiiiiiiiiiiie et e e e et e e e e et tee e e e st et e e e e snteeeeeeanseeeeeeennees 102
e A e A T 1] T 1 ST PRRR 107
EVENt > EVENT SEHINGS. ...ttt e e e e e e e e e e e e e e e e e e e e nnnneeeeees 111
Applications > MOtioN det@CON. .......oooi e 125
Applications > DI and DO .....ooooiiieee e e e e e e e e e e e aaaaaaaas 128
Applications > Tampering deteClioN ..........oooi i 129
Applications > AUIO AELECHION  .....eeeeeei et e e e e e e e e e et e e e et eae e 130
Applications > Package management - a.k.a., VADP (VIVOTEK Application Development Platform) ....... 132
Recording > ReCOrding SEtHNGS ...ccoiiiiieiiieieiii ettt e e e e e e e e e e e e e e e e e eeees 135
Local storage > SD card ManagemMeENnt...........ooiuuuiiiiiiiiiiie et e e e e e e e e e e e naees 140
Local storage > Content ManagemeENnt ...........ooiuiiiieiiiiiie et e e e e e e e e e e et ae e e e e nnreeaeeennees 141



URL Commands for the NetWork Camera....... ... e e e e 144

Technical SPECIfICALIONS .........coiiieee e e e e e e e e e e e e e e e e e e et e e e e e eeaaaeeas 317
TechnNOlOgY LiCENSE NOLICE. ..o et e et e et e e e e anbe e e e e e nnees 319
Electromagnetic Compatibility (EMOC)........cooiiiiiiiiiiieeee e e e e e e e e e 320

Overview

VIVOTEK’s FD836BA is a series of robust, dome-style network cameras designed for diverse
outdoor applications and offering a broad range of options. Equipped with a Full HD sensor
enabling viewing resolution of 1920x1080 at a smooth 30 fps, the FD836BA series is an all-in-one
outdoor cameras capable of capturing high quality and high resolution video at up to 2 Megapixels
whether in high contrast or low light with WDR and SNV technology.

Further increasing its flexibility, VIVOTEK’s FD836BA series provides options for both fixed focus
for simple operation without extra electrical power, and remote focus with built-in stepping motors
and P-iris to provide precise adjustment remotely.

To meet the demands of any harsh outdoor application, VIVOTEK’s FD836BA series is also armed
with IP66-rated housing to help the camera body withstand rain, dust and high pressure water
jets from any direction, while its IK10-rated housing provides robust protection against acts of
vandalism or other impacts.

Finally, a wide operating temperature range further enhances the camera’s performance and
reliability in extremely cold or hot weather, even when using PoE. When choosing VIVOTEK
FD836BA series, customers will be offered four options: the FD836BA-HVF2, FD836BA-EHVF2,
FD836BA-HTV, and FD836BA-EHTV. Different options can be chosen based on the requirements
of your application, such as the need for a specific focusing method or operating environment
temperature.

With the highly flexible VADP (VIVOTEK Application Development Platform), users can extend the
features of this series by adding third-party applications for the camera. Thus, the series is not only
equipped with multiple focusing methods and wide temperature range options, is but ideal for a
wide variety of applications.



Revision History

m Rev. 1.0: Initial release.

Read Before Use

The use of surveillance devices may be prohibited by law in your country. The Network Camera
is not only a high-performance web-ready camera but can also be part of a flexible surveillance
system. It is the user’s responsibility to ensure that the operation of such devices is legal before
installing this unit for its intended use.

It is important to first verify that all contents received are complete according to the Package
Contents listed below. Take note of the warnings in the Quick Installation Guide before the Network
Camera is installed; then carefully read and follow the instructions in the Installation chapter to
avoid damage due to faulty assembly and installation. This also ensures the product is used
properly as intended.

The Network Camera is a network device and its use should be straightforward for those who
have basic networking knowledge. It is designed for various applications including video sharing,
general security/surveillance, etc. The Configuration chapter suggests ways to best utilize the
Network Camera and ensure proper operations. For creative and professional developers, the URL
Commands of the Network Camera section serves as a helpful reference to customizing existing
homepages or integrating with the current web server.

Package Contents

m FD836BA-HVF2, FD836BA-HTV, FD836BA-EHVF2, FD836BA-EHTV

m Screw pack
m Quick Installation Guide & alignment sticker

Symbols and Statements in this Document

INFORMATION: provides important messages or advices that might help prevent
inconvenient or problem situations.

/ NOTE: Notices provide guidance or advices that are related to the functional integrity of
the machine.

N ' “ Tips: Tips are useful information that helps enhance or facilitae an installation, function,
@ or process.

WARNING! or IMPORTANT!: These statements indicate situations that can be
dangerous or hazardous to the machine or you.

& Electrical Hazard: This statement appears when high voltage electrical hazards might
occur to an operator.



Physical Description

IR LEDs

Motorized or
fixed lens

SD/SDHC/SDXC Terminal block
Card Slot
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< Ethernet port
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Reset button

@ NOTE:

The "T" and "HT" models have an auto-focus motorized lens. Some of the suffix syntax are
listed below:

w/ heater for extreme weather
Focal length w/ number

w/ Remote focus lens

w/ PoE repeater

w/ High Dynamic Range functionality also known as WDR
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Hardware Installation

1.Jot down the camera's MAC address for later reference. This is especially important if
you install numerous cameras at an installation site.

o

Network Camera ¥ VIVOTEK

' q’

N
MAC: 0002D1083236 |_ X000
W-@

2.Remove the dome cover by loosening the retention screws on the dome cover.




3.Loosen and remove the waterproof connectors. Discard the plastic stopper inside the 10
connector

13/

5~6.3mm

[ANENI ]

% DI/DO: 1.8~2.1mm




4. Insert an Ethernet cable through the cabling hole.

5. Insert the Ethernet cable through the cable gland, and the rubber seal.




6. Remove part of cable sheath.
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7.You will need an RJ45 crimping tool to attach the Ethernet wires to a connector. When
done, connect the cable to the camera’s Ethernet RJ45 socket.

o: white/orange stripe
S Q: orange solid

= g: white/green stripe

B: blue solid

b: white/blue stripe
G: green solid

br: white/brown stripe
BR: brown solid

0
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8. Secure the connection by tightening the waterproof components.

9.Secure the 10 cable connection by tightening the waterproof components. Note that the
waterproof cable rubber seal must be installed whether you connect |O wires or not.




10. If applied, connect DI/DO wires, 12V DC power, or audio wires to the terminal block.

Name

EXT _MIC N
EXT MIC P
Audio_out-
Audio out+
DI-

DI+

DO-

DO+

12V DC-_IN
0 (12vV DC+_IN

2O [N|O|O|A[WIN|[—~H

11. Attach the included alignment sticker to a preferred location. Drill holes for mounting
screws and if preferred, drill one or two routing holes.

——




12. When fastening the screws, do not completely tighten the screws. Pass cables through
the routing holes, and then mount the camera by passing the screw heads through the
keyhole slots. Turn the camera counter-clock wise, and then fasten the screws.

13. If you route your cables through the side opening, you can use the side bushing to
connect a protective 3/4" conduit. The conduit is user-supplied. You can use the included
screws to secure the side bushing to wall.




VIVOTEK

Please avoid using a conduit with a hex nut larger than 35mm.

<3/4”

14. Install the "Installation Wizard 2" software utility from your software CD. The program
will search for VIVOTEK Video Receivers, Video Servers or Network Cameras on the

same LAN. qfﬂ

Double-click on the camera’s MAC address to open a browser management session
with the camera.

®
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15. With a live view displayed on your laptop, adjust the zoom and focus to obtain an
optimal image. Check the live view to ensure the image is in focus.

The "T" models comes with motorized focus lens. Use the Auto Focus function in
firmware menu for best image.




17. Align and install the dome cover.
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18. Remove the protection membrane from the dome cover.

LED Definitions

Item [LED status Description
1 Steady Red Powered and system booting, or network failed
Red LED off Power off

Green LED off

Network is disconnected

suoniuly 8@ A3l

2 Steady Red and Green LED blinks every 1 |Connected to network
sec.
3 Green LED blinks every 1 sec. and RED Upgrading firmware
LED blinks consecutively every 0.15 sec.
4 Green and RED blink every 0.15 sec, Green |Restoring defaults
and RED light on, then blink again.
5 RED LED is on, Green LED blinks and RED |Status after a reset (network connected)

LED is constantly on.

Green and RED LEDs are constantly on.

Status after a reset (network disconnected)




Hardware Reset

The reset button is used to reset the system or restore the factory default settings.
Sometimes resetting the system can return the camera to normal operation. If the system
problems remain after reset, restore the factory settings and install again.

Reset: Press the recessed reset button. Wait for the Network Camera to reboot.

Restore: Press and hold the reset button until the status LED rapidly blinks. Note that all
settings will be restored to factory default. Upon successful restore, the status LED will
blink green and red during normal operation.

SD/SDHC/SDXC Card Capacity

This network camera is compliant with SD/SDHC/SDXC 16GB / 8GB / 32GB / 64GB and
other preceding standard SD cards.



Network Deployment
General Connection (PoE)

(O When using a PoE switch

The Network Camera is PoE-compliant, allowing transmission of power and data via a sin-
gle Ethernet cable. Follow the illustration below to connect the Network Camera to a PoE
switch via an Ethernet cable.

802.3af

PoE Switch

O When using a non-PoE switch

Use a PoE power injector (optional) to connect between the Network Camera and a non-
PoE switch.

PoE Power Injector
(optional)

:s Non-PoE Switch
4§ NOTE:

1. The camera is only to be connected to PoE networks without routing to outside plants.
2. For PoE connection, use only UL listed I.T.E. with PoE output.




Internet connection via a router

Before setting up the Network Camera over the Internet, make sure you have a router and follow
the steps below.

1. Connect your Network Camera behind a router, the Internet environment is illustrated below.
Regarding how to obtain your IP address, please refer to Software Installation on page 20 for

details.
E ]
-
| Lt
IP address : 192.168.0.3
Subnet mask : 255.255.255.0
WAN (Wide Area Network )

Default router : 192.168.0.1
Router IP address : from ISP,

Internet

LAN (Local Area Network)
Router IP address : 192.168.0.1

Cable or DSL Modem ‘ [g

T

IP address : 192.168.0.2
Subnet mask : 255.255.255.0
Default router : 192.168.0.1

2. In this case, if the Local Area Network (LAN) IP address of your Network Camera is
192.168.0.3, please forward the following ports for the Network Camera on the router.

m HTTP port: default is 80

m RTSP port: default is 554

m RTP port for video: default is 5556
m RTCP port for video: default is 5557

If you have changed the port numbers on the Network page, please open the ports
accordingly on your router. For information on how to forward ports on the router, please refer
to your router’s user’s manual.

3. Find out the public IP address of your router provided by your ISP (Internet Service Provider).

Use the public IP and the secondary HTTP port to access the Network Camera from the
Internet. Please refer to Network Type on page 77 for details.

Internet connection with static IP

Choose this connection type if you are required to use a static IP for the Network Camera.
Please refer to LAN setting on page 76 for details.

Internet connection via PPPoE (Point-to-Point over Ethernet

Choose this connection type if you are connected to the Internet via a DSL Line. Please refer to
PPPoE on page 77 for details.



Configure the router, virtual server or firewall, so that the router can forward any data com-
ing into a preconfigured port number to a network camera on the private network, and
allow data from the camera to be transmitted to the outside of the network over the same
path.

From Forward to
122.146.57.120:8000 (192.168.2.10:80
122.146.57.120:8001 [192.168.2.11:80

When properly configured, you can access a camera behind the router using the HTTP
request such as: http://122.146.57.120:8000

If you change the port numbers on the Network configuration page, please open the ports
accordingly on your router. For example, you can open a management session with your
router to configure access through the router to the camera within your local network.
Please consult your network administrator for router configuration if you have troubles with
the configuration.

For more information with network configuration options (such as that of streaming ports),
please refer to Configuration > Network Settings. VIVOTEK also provides the automatic
port forwarding feature as an NAT traversal function with the precondition that your router
must support the UPnP port forwarding feature.

Gaf # pddreas autcrmabcaly
erM peitngs Lse Bxed P addness

Sfrearmang piabndoie ¢ Ennbie UPs@ presemiaion

jalali L] 4| Enable UPsP par farsarding

Gl PRRGE

SN #| Enabie PvE

The device m coafigunng now. Vit Brow et will reconnact
IPwvh infoemmd G bHp 09 1584 180 B0V
Hiha connecion inls, pltass manualy anber the sbove F
LT P T

- — )
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VIVOTEK

Software Installation

Installation Wizard 2 (IW2), a software included in the product CD, helps you set up your
Network Camera on the LAN.

1. Install IW2 under the Software Utility directory from the software CD.
Double-click the IW2 shortcut on your desktop to launch the program.

Installation
Wizard 2

2. The program will conduct an analysis of your network environment.
After your network environment is analyzed, please click Next to continue the program.

Your network environment was anafyzed as below,
Private DHCP

The wizard iz anakyzing your nebwork snvirenmant,
@ Fleage wait 8 mament.

0—1& —
£ absie. 0185

g

LTI J

3. The program will search for all VIVOTEK network devices on the same LAN.

4. After a brief search, the installer window will prompt. Click on the MAC and model name
that matches the one printed on the product label. You can then double-click on the address
to open a management session with the Network Camera.

RoHS
MAC:0002D1730202 c € e

OV FC o
192.168.5.151 FD836BA

00-02-D1-73-02-02

0002D1730202

Plagss clesch s BAC asd madsl wams s the
product latl af yeur devics fimt.

Tham, jreu can stan 10 sk g yenn davice and
show Be main scrven by deubles cicking e
Item in s abeve selaction s,

I you wie not akde s lind yous devics s the

abave sulactlan lint, plaass maks uss sl

cables aie pioparly connacied to your devien 790 09 Tnd She produect labst in
and then tleck on e Ralresh Devdoes™ e rwas Bafup pan of your
hisman, dmvice.
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Ready to Use

1. A browser session with the Network Camera should prompt as shown below.

2.You should be able to see live video from your camera. You may also install the 32-channel
recording software from the software CD in a deployment consisting of multiple cameras. For
its installation details, please refer to its related documents.

| Yviversk FD836BA

Vidensimam ¢ - EErr=]s s BT cesnrsaningy  Confguiaces | Languags

o2 a8 L@ () [ G0 - zecione— -




Auto Focus (for Motorized Lens Models only)

On the web console, visit the Configuration > Image > Focus window. Perform the Auto
Focus function for best image focus.

Focus here refers to the Remote Focus, applicable to Network Cameras that are equipped
with a stepping motor lens. The automated focus adjustment function eliminates the needs
to physically adjust camera focus. In an outdoor deployment consisting of a large number
of cameras, the auto focus function can be very helpful when these cameras become out
of focus after days or weeks of operation. And that can easily result from the effects of
natural forces, e.g., shrink and expand due to a wide range of operating temperatures and
the vibration caused by wind.

sl nuilign  bnege sellings | Expuaws Freus  Priv scy mash

Fogun

Ao Fedsi
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Accessing the Network Camera

This chapter explains how to access the Network Camera through web browsers, RTSP players,
3GPP-compatible mobile devices, and VIVOTEK recording software.

Using Web Browsers

Use Installation Wizard 2 (IW2) to access the Network Cameras on LAN.

If your network environment is not a LAN, follow these steps to access the Netwotk Camera:

1. Launch your web browser (e.g., Microsoft® Internet Explorer or Mozilla Firefox).

2. Enter the IP address of the Network Camera in the address field. Press Enter.

3. Live video will be displayed in your web browser.

4. If it is the first time installing the VIVOTEK network camera, an information bar will prompt as
shown below. Follow the instructions to install the required plug-in on your computer.

Dt bl e e[~
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NOTE:

» For Mozilla Firefox or Chrome users, your browser will use Quick Time to stream the live
video. If you don’t have Quick Time on your computer, please download it first, then launch
the web browser.

i s o — | et | e | e w————— [hre | [ = @
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» By default, the Network Camera is not password-protected. To prevent unauthorized access,
it is highly recommended to set a password for the Network Camera.
For more information about how to enable password protection, please refer to Security on
page 94.

» If you see a dialog box indicating that your security settings prohibit running ActiveX®
Controls, please enable the ActiveX® Controls for your browser.

1. Choose Tools > Internet Options > Security > Custom Level.

Internet Options

General| Secuity | Privacy | Content | Connections | Programs | Advanced

Select a'web content zone to specify itz security settings.

® €« 0 @
Localintranet  Trusted sites  Restricted
gihes

Internet

Thiz zohe containg all 'web sites you
haven't placed in ather zones

Security level for this zone

Custom
Cusztom zettings.
- To chahge the settings, click Customn Level.
- Ta use the recommended settings, click Default Level

’ Custom Lewvel .. ] Default Level ]

[ 0k H Canicel ]

2. Look for Download signed ActiveX® controls; select Enable or Prompt. Click OK.

Setkings:

Activer controls and plug-ins ”
E] Dovnload signed Activer controls
() Disable
II:II Enable
(@) Promnpk
] Download unsigned Activei conkrols
() Disable
IIEII Enable
'Z:_:Z' Pronipk
E] Initialize and scripk ActiveX controls nok marked as safe
() Disable
IIEII Enable
'Z:_:Z' Pronipk

[ I TSI, WS SRy ¥ R SpRpy ey PRppepups [Py RPpepr R,

£ b4

Reset cuskom setkings

Reset ka: | Medium b

[ oK l[ Cancel ]

3. Refresh your web browser, then install the ActiveX® control. Follow the instructions to
complete installation.



A IMPORTANT:

Currently the Network Camera utilizes 32-bit ActiveX plugin. You CAN NOT open a
management/view session with the camera using a 64-bit |IE browser.

If you encounter this problem, try execute the lexplore.exe program from C:\Windows\
SysWOW64. A 32-bit version of IE browser will be installed.

On Windows 7, the 32-bit explorer browser can be accessed from here:
C:\Program Files (x86)\Internet Explorer\iexplore.exe

If you open a web session from the IW2 utility, a 32-bit IE browser will be opened.

-‘@’- Tips:
1. The onscreen Java control can malfunction under the following situations: A PC con-

nects to different cameras that are using the same IP address (or the same camera

running different firmware versions). Removing your browser cookies will solve this
problem.

2. If you encounter problems with displaying the configuration menus or Ul items, try dis-
able the Compatibility View on IE8 or IE9.

e

You may also press the F12 key to open the developer tools utility, and then change the
Browser Mode to the genuine IE8 or IE9 mode.

" joinsmsn.com D-RIc X [

e El@
File Find Disable View Images Cache Tools Validate Document Mode: IEQ standards =
HTML | CS5 Console GScript Profiler Netwark Internet Explorer 7 e
[} w2 H 4 B Internet Explorer &

- <IDOCTYPE html PUBLIC "-//W3C//DTD XHTHL 1.p | Y  IntemetExplorerd

+-<html xmlns="http:// www.1 F1999 xhtml™ > Internet Explorer @ Compatibility View

* In the event of plug-in compatibility issues, you may try to uninstall the plug-in that was
previously installed.

Business Explorer
Camera Stream Contraller
¢ Uninstall

Catalyst Control Center

m



Using RTSP Players

To view the streaming media using RTSP players, you can use one of the following players that
support RTSP streaming.

(ﬁ Quick Time Player
;f}, VLC media player

1. Launch the RTSP player.

2. Choose File > Open URL. A URL dialog box will pop up.

3. The address format is rtsp://<ip address>:<rtsp port>/<RTSP streaming access name for
stream1 or stream2>

As most ISPs and players only allow RTSP streaming through port number 554, please set the
RTSP port to 554. For more information, please refer to RTSP Streaming on page 85.
For example:

Enter an Intermet LIRL to open:

rtsp://1 92.168.54151l554/Iive.sdpl ~ |

4. The live video will be displayed in your player.
For more information on how to configure the RTSP access name, please refer to RTSP
Streaming on page 85 for details.
| e EE

Fig - Edtc. Vaww Window _Haln
Video 16:38:01 2012/01/25
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Using 3GPP-compatible Mobile Devices

To view the streaming media through 3GPP-compatible mobile devices, make sure the Network
Camera can be accessed over the Internet. For more information on how to set up the Network
Camera over the Internet, please refer to Setup the Network Camera over the Internet on page

17.

To utilize this feature, please check the following settings on your Network Camera:

1. Because most players on 3GPP mobile phones do not support RTSP authentication, make
sure the authentication mode of RTSP streaming is set to disable.
For more information, please refer to RTSP Streaming on page 85.

2. As the the bandwidth on 3G networks is limited, you will not be able to use a large video size.

Please set the video streaming parameters as listed below.
For more information, please refer to Stream settings on page 66.

Video Mode H.264
Frame size 176 x 144
Maximum frame rate 5 fps
Intra frame period 1S

Video quality (Constant bit rate) 40kbps

3. As most ISPs and players only allow RTSP streaming through port number 554, please set
the RTSP port to 554. For more information, please refer to RTSP Streaming on page 85.

4. Launch the player on the 3GPP-compatible mobile devices (e.g., Quick Time).

5. Type the following URL commands into the player.
The address format is rtsp://<public ip address of your camera>:<rtsp port>/<RTSP streaming

access name for stream # with small frame size and frame rate>.
For example:

i

Enter an Internet URL to open:
Iitsp/#192.168.4.147. 554/ lived sdp |

] | Cancel ‘

You can configure Stream #2 into the suggested stream settings as listed above for live
viewing on a mobile device.




Using VIVOTEK Recording Software

The product software CD also contains a VAST recording software, allowing simultaneous
monitoring and video recording for multiple Network Cameras. Please install the recording
software; then launch the program to add the Network Camera to the Channel list. For detailed
information about how to use the recording software, please refer to the user’s manual of the
software or download it from http://www.vivotek.com.
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-‘@’- Tips:

1. If you forget the root (administrator) password for the camera, you can restore the camera
defaults by pressing the reset button for longer than 5 seconds.

2. If DHCP is enabled in your network, and the camera cannot be accessed, run the IW2 utility
to search the network. If the camera has been configured with fixed IP that does not comply
with your local network, you may see its default IP 169.254.x.x. If you still cannot find the
camera, you can restore the camera to its factory defaults.

3. If you change your network parameters, e.g., added a camera via a connection to a LAN
card, re-start the IW2 utility.


http://www.vivotek.com

Main Page

This chapter explains the layout of the main page. It is composed of the following sections:
VIVOTEK INC. Logo, Host Name, Camera Control Area, Configuration Area, Menu, and Live
Video Window.

Resize Buttons

VIVOTEK INC. | % VIVETEK FD836BA Host Name
Logo o T TTr—— Configuration
= T Area

et

Camera Control
Area

|
Hide Button ——_

Live View Window

VIVOTEK INC. Logo
Click this logo to visit the VIVOTEK website.

Host Name
The host name can be customized to fit your needs. The name can be changed especially there are many
cameras in your surveillance deployment. For more information, please refer to System on page 40.

Camera Control Area

Video Stream: This Network Camera supports multiple streams (streams 1 and 2) simultaneously. You
can select any of them for live viewing. For more information about multiple streams, please refer to page
66 for detailed information.

Manual Trigger: Click to enable/disable an event trigger manually. Please configure an event setting on
the Application page before you enable this function. A total of 3 event configuration can be configured.
For more information about event setting, please refer to page 110. If you want to hide this item on
the homepage, please go to Configuration> System > Homepage Layout > General settings >
Customized button to deselect the “show manual trigger button” checkbox.




Configuration Area

Client Settings: Click this button to access the client setting page. For more information, please refer to
Client Settings on page 34.

Configuration: Click this button to access the configuration page of the Network Camera. It is suggested
that a password be applied to the Network Camera so that only the administrator can configure the
Network Camera. For more information, please refer to Configuration on page 39.

Language: Click this button to choose a language for the user interface. Language options are available

in: English, Deutsch, Espafiol, Frangais, Italiano, P # 3, Portugués, f§ i+ <, and %% * . Please
note that you can also change a language on the Configuration page; please refer to page 39.

Hide Button
You can click the hide button to hide or display the control panel.

Resize Buttons

B Aurbof B 1004 EH 50% [ Bd 25% |

Click the Auto button, the video cell will resize automatically to fit the monitor.
Click 100% is to display the original homepage size.

Click 50% is to resize the homepage to 50% of its original size.

Click 25% is to resize the homepage to 25% of its original size.

Live Video Window

m The following window is displayed when the video mode is set to H.264:
H.264 Protocol and Media Options
Video Title [ vided (TPC-AV) 2015/03/25 17:08:56 Time
Title and Time | Video 17:0856 2015/03/25 I

Zoom Indicator

Video Control Buttons

Video Title: The video title can be configured. For more information, please refer to Video Settings on
page 52.

H.264 Protocol and Media Options: The transmission protocol and media options for H.264 video
streaming. For further configuration, please refer to Client Settings on page 34.

Time: Display the current time. For further configuration, please refer to Media > Image > Genral settings
on page 52.

Title and Time: The video title and time can be stamped on the streaming video. For further configuration,
please refer to Media > Image > General settings on page 57.



PTZ Panel: This Network Camera supports “digital“ (e-PTZ) pan/tilt/zoom control, which allows roaming
a smaller view frame within a large view frame. Please refer to PTZ settiings on page 107 for detailed
information.

Global View: Click on this item to display the Global View window. The Global View window contains a
full view image (the largest frame size of the captured video) and a floating frame (the viewing region of
the current video stream). The floating frame allows users to control the e-PTZ function (Electronic Pan/
TiltYZoom). For more information about e-PTZ operation, please refer to E-PTZ Operation on page 107.
For more information about how to set up the viewing region of the current video stream, please refer to
page 107.

= Global View:

The viewing region of
the curruent video
stream

The largest frame size

Maving Instantly

Note that the PTZ buttons on the panel are not operational unless you are showing only a portion of the
full image. If the live view window is displaying the full view, the PTZ buttons are not functional.



Video Control Buttons: Depending on the Network Camera model and Network Camera configuration,
some buttons may not be available.

¥ Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.

2 Digital Zoom: Click and uncheck “Disable digital zoom” to enable the zoom operation. The navigation
screen indicates the part of the image being magnified. To control the zoom level, drag the slider bar. To
move to a different area you want to magnify, drag the navigation screen.

Disable digital ptz

Zoom Factar:

-
- 100% 400%
|

IEI Pause: Pause the transmission of the streaming media. The button becomes the ' » | Resume button
after clicking the Pause button.

- Stop: Stop the transmission of the streaming media. Click the | ® Resume button to continue
transmission.

|» | Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.

Press the |E| Stop MP4 Recording button to end recording. When you exit the web browser, video
recording stops accordingly. To specify the storage destination and file name, please refer to MP4 Saving

Options on page 35 for details.

@ Volume: When the |"¥2| Mute function is not activated, move the slider bar to adjust the volume on the
local computer.

)| Mute: Turn off the volume on the local computer. The button becomes the | | Audio On button after
clicking the Mute button.

¥ Talk: Click this button to talk to people around the Network Camera. Audio will project from
the external speaker connected to the Network Camera. Click this button @ again to end talking
transmission.

@ Mic Volume: When the | ¥ Mute function is not activated, move the slider bar to adjust the
microphone volume on the local computer.

NOTE:

1. For a megapixel camera, it is recommended to use monitors of the 24" size or larger, and
are capable of 1600x1200 or better resolutions.
2. Below are the defaults for Audio settings:
For cameras with built-in microphone: Not Muted.
For cameras without built-in microphone: Muted.

To receive audio input from an external microphone, you may need to enable the audio input
from Media > Audio. Refer to page 75 for more information.



W Mute: Turn off the Mic volume on the local computer. The button becomes the Mic On button
after clicking the Mute button.

@ Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.

m The following window is displayed when the video mode is set to MJPEG:

Video Title Vided| (HTTP-V)
Title and Time | video 17:08:56 2015/07/25 l

Time

D[E ﬂ E e Video Control Buttons

Video Title: The video title can be configured. For more information, please refer to Media > Image on
page 57.

Time: Display the current time. For more information, please refer to Media > Image on page 57.

Title and Time: Video title and time can be stamped on the streaming video. For more information, please
refer to Media > Image on page 57.

Video Control Buttons: Depending on the Network Camera model and Network Camera configuration,
some buttons may not be available.

E Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.omp) format.

]E Digital Zoom: Click and uncheck “Disable digital zoom” to enable the zoom operation. The navigation
screen indicates the part of the image being magnified. To control the zoom level, drag the slider bar. To
move to a different area you want to magnify, drag the navigation screen.

[C] Disable digital ptz

Zoom Factor:
PALF

- 100% 400%
i

F Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.
Press the Stop MP4 Recording button to end recording. When you exit the web browser, video
recording stops accordingly. To specify the storage destination and file name, please refer to MP4 Saving
Options on page 35 for details.

ﬁ Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.



Client Settings

This chapter explains how to select the stream transmission mode and saving options on the
local computer. When completed with the settings on this page, click Save on the page bottom
to enable the settings.

H.264 Media Options

H.264 media options

Video only
Audio only

Select to stream video or audio data or both. This is enabled only when the video mode is set to H.264.

H.264 Protocol Options

H.264 protocol options

TCP v]

UDP Unicast
UDP Multicast

HTTP

Depending on your network environment, there are four transmission modes of H.264 streaming:

UDP unicast: This protocol allows for more real-time audio and video streams. However, network
packets may be lost due to network burst traffic and images may be broken. Activate UDP connection
when occasions require time-sensitive responses and the video quality is less important. Note that each
unicast client connecting to the server takes up additional bandwidth and the Network Camera allows up
to ten simultaneous accesses.

UDP multicast: This protocol allows multicast-enabled routers to forward network packets to all clients
requesting streaming media. This helps to reduce the network transmission load of the Network Camera
while serving multiple clients at the same time. Note that to utilize this feature, the Network Camera must
be configured to enable multicast streaming at the same time. For more information, please refer to
RTSP Streaming on page 85.

TCP: This protocol guarantees the complete delivery of streaming data and thus provides better video
quality. The downside of this protocol is that its real-time effect is not as good as that of the UDP protocol.

HTTP: This protocol allows the same quality as TCP protocol without needing to open specific ports for
streaming under some network environments. Users inside a firewall can utilize this protocol to allow
streaming data through.



Two way audio

Two way audio

Ha

f-duplex
Full-duplex

Half duplex: Audio is transmitted from one direction at a time, e.g., from a PC holding a web console with
the camera.

Full duplex: Audio is transmitted in both directions simultaneously.

MP4 Saving Options

MP4 saving options

Folder: C\Record

File name prefix cLIP

Add date and ime suffixio file name

Users can record live video as they are watching it by clicking W Start MP4 Recording on the main
page. Here, you can specify the storage destination and file name.

Folder: Specify a storage destination on your PC for the recorded video files. The location can be
changed.

File name prefix: Enter the text that will be appended to the front of the video file name. A specified folder
will be automatically created on your local hard disk.

Add date and time suffix to the file name: Select this option to append the date and time to the end of the
file name.

( 1\

CLIP_20150321-180853

tt

File name prefix ~ Date and time suffix
The format is: YYYYMMDD_HHMMSS

Local Streaming Buffer Time

Local streaming buffer time

0 Millisecond

| save |

Due to the unsteady bandwidth flow, the live streaming may lag and not be very smoothly. If you enable
this option, the live streaming will be stored temporarily on your PC’s cache memory for a few seconds
before being played on the live viewing window. This will help you see the streaming more smoothly. If
you enter 3,000 Millisecond, the streaming will delay for 3 seconds.



Joystick settings

Enable Joystick

Connect a joystick to a USB port on your management computer. Supported by the plug-in
(Microsoft’s DirectX), once the plug-in for the web console is loaded, it will automatically detect if
there is any joystick on the computer. The joystick should work properly without installing any other
driver or software.

Then you can begin to configure the joystick settings of connected devices. Please follow the
instructions below to enable joystick settings.

1. Select a detected joystick, if there are multiple, from the Selected joystick menu. If your joystick
is not detected, if may be defective.

2. Click Calibrate or Configure buttons to configure the joystick-related settings.

Joystick settings

Selected joystick. | [TETETMINEN [~
| Calibrate | | Configure buttons

| Save |

NOTE:

* If you want to assign Preset actions to your joystick, the preset locations should be configured in
advance in the Configuration > PTZ page.

+ If your joystick is not working properly, it may need to be calibrated. Click the Calibrate button
to open the Game Controllers window located in Microsoft Windows control panel and follow the
instructions for trouble shooting. Use the Search panel on the Start menu to search for “Game
Controller.”

» The joystick will appear in the Game Controllers list in the Windows Control panel. If you want to
check out for your devices, go to the following page: Start -> Control Panel -> Game Controllers.

Game Controllers E]@

2. Theze zettings help you configure the game controllers installed on
|

o
G—'h pour cormputer.

Inztalled game contrallers

Contraller Statuz
CH PRODUCTS IF DESKTOF CONTROLLER

Add... ] [ Femaove ] [ Properties ]

[ Advanced... ][ Troublezhoot, . ]




Buttons Configuration

In the Button Configuration window, the left column shows the actions you can assign, and the right
column shows the functional buttons and assigned actions. The number of buttons may differ from

different joysticks.

Please follow the steps below to configure your joystick buttons:

1. Choosing one of the actions and click Assign will pop up a dialog. Then you can assign this
action to a button by pressing the joystick button or select it from the drop-down list.
For example: Assign Home (move to home position) to Button 1.

i\l
Assigned Actions

Actions

oarm 16
Zoorm Cut

+- Focus

+- Iris
Pan
Stop
Patrol

+- Preset
Page p
Page Downh
Record to AV
Shapshot Auto Mamming

x|

Buttons Azzigned Actions

PN
% "Home"

3

Press the joystick button to assign to "Home" or
select the button from the list below,

[Buttonl
Buttonz
Button3
Buttond
ButtonS
ButtonG
Button?
Buttong

] [ Cancel

Buttong

Buttonl0
Buttonll
Buttonlz

Canicel

J

2. Click OK to confirm the configuration.

.U
Aszigned Actions

Actions

¥ "Home"

Home
Zoam In
Zoom Ot
+-Focus
£ Iris
Pan
Stop
Patrol
= Preset
Prezet]
Preszetd
Preszet3
Preszet4

Buttonl

Press the joystick button to assign to "Horme" or
select the button from the list below.

Click "Ck" to assign " to buttonl

Lssign

Clear Selected

] [ Cancel




Buttons Configuration

Click the Configure Buttons button, a window will prompt as shown below. Please follow the steps
below to configure your joystick buttons:
1. Select a button number from the Button # pull-down menu.

€] http://192.168.6.231/setup//canfigure_buttens.html

B -‘@’- Tips:

_ If you are not sure of the locations of each
Actions:  Toggle playipause _[=] button, use the Properties window in the Game
Controllers utility.
Button: |1
e =
2 g Ten |
Button |3 Assigned Actions e L 1= :'JF-‘-:‘?'L'L‘-'-'-T:-'HW.'.?""*
1 ; Full Screen | T Tonsrnt s o e b s o o
2 |6 Stop il e e —
3 ! Zoomin i!a'-::-m = l
g
4 2] i ' 18
5 :11.0] Patrol L S ol v Wt
6 12 | T ! 08000000
aggle play/pause o e ey b bE —
7 [®)
g T N
9 ta
10 * ) _fee J
11
12 Snapshot
€ EREDE | SR M ‘a v E100% o~

2. Select a corresponding action, such as Patrol or Preset#.

@ hitp,//192.168.6 23 1/etapreontigureb. szl | 3. Click the Assign button to assign an action
| to the button. You can delete an association
by selecting a button number, and then click
the Delete button.

| | http//192.168.6.231 /setup/configure_buttons htrl

>=Joystick Settings
Actions:  Toggle play/pause -
Toggle play/pause - ml

Stop streaming

Button: | {Snapshot Delete

Full g
Stuamsctroepepecoramg The buttons you define should appear on the
Button |P3N button list accordingly.

Patrol
Stop
Zoomin
Zoom out

Repeat the process until you are done with
the configuration of all preferred actions.

—

Digital output on/off 1

Digital output on/off 2

Digital output on/off 3

Digital output on/off 4

Manual trigger on/off 1
Manual trigger on/off 2
Manual trigger on/off 3
Preset 1

Preset 2

Preset 3

Presetd

Preset5

Preset&

Preset7

Preset 8

Presetd

Preset 10

Preset 11

Preset 12
WPresetﬂ

[{= R = T N = N = ]

[
[C

. Please remember to click the Save button

on the Client settings page to preserve your
settings.



Configuration

Click Configuration on the main page to enter the camera setting pages. Note that only
Administrators can access the configuration page.

VIVOTEK provides an easy-to-use user interface that helps you set up your network camera
with minimal effort. In order to simplify the user interface, detailed information will be hidden
unless you click on the function item. When you click on the first sub-item, the detailed
information for the first sub-item will be displayed; when you click on the second sub-item, the
detailed information for the second sub-item will be displayed and that of the first sub-item will
be hidden.

The following is the interface of the main page:

% viver=k

W VY ST e & S m Home Client settings ESIHITEGLLE Language

System > General settings

System Navigation Area

General settings Host name: Wega-Pixel Network Camera

Home e layout
L [] Turn off the LED indicator

Logs
Parameters System time

Maintenance
Time zone: | GMT+08:00 Beiing, Chongging, Hong Kong, Kuala Lumpur, Singapore, TaipeiE

Media Mote: Wou can upload your daylight saving time rules on Maintenance page or use the camera default
value.
MNetwork

@ Keep current date and time
Security ©) Synchronize with computer time
PTZ ) Manual

) Automatic
Event

Save

Applications

Configuration List

Recording

Local storage

Version: 0100a Firmware Version

Each function on the configuration list will be explained in the following sections.

The Navigation Area provides access to all different views from the Home page (for live viewing),
Configuration page, and multi-language selection.



VIVOTEK

System > General settings

This section explains how to configure the basic settings for the Network Camera, such as the
host name and system time. It is composed of the following two columns: System, and System
Time. When finished with the settings on this page, click Save at the bottom of the page to
enable the settings.

System

| System
Host rarme: Mega-Pixel Metwork Camera

] |'I’-urn off the LED indicater

Host name: Enter a desired name for the Network Camera. The text will be displayed at the top of the
main page, and also on the view cells of the ST7501 and VAST management software.

Turn off the LED indicators: If you do not want others to notice the network camera is in operation, you
can select this option to turn off the LED indicators.

40 - User's Manual




System time
System time

Time zone:  GMT+08:00 Beiiing, Chonaaing, Hona Kena, Kuala Lumpur, Singapore, Taipei (=]

Mote: You can upload your daylight saving time rules on Maintenance page or use the camera
default value.

@ Keep current date and time
Synchronize with computer time
Manual

Automatic

| Save |

Keep current date and time: Select this option to preserve the current date and time of the Network
Camera. The Network Camera’s internal real-time clock maintains the date and time even when the
power of the system is turned off.

Synchronize with computer time: Select this option to synchronize the date and time of the Network
Camera with the local computer. The read-only date and time of the PC is displayed as updated.

Manual: The administrator can enter the date and time manually. Note that the date and time format are
[yyyy/mm/dd] and [hh:mm:ss].

Automatic: The Network Time Protocol is a protocol which synchronizes computer clocks by periodically
querying an NTP Server.

NTP server: Assign the IP address or domain name of the time-server. Leaving the text box blank
connects the Network Camera to the default time servers. The precondition is that the camera must
have the access to the Internet.

Update interval: Select to update the time using the NTP server on an hourly, daily, weekly, or monthly
basis.

Time zone : Select the appropriate time zone from the list. If you want to upload Daylight Savings Time
rules, please refer to System > Maintenance > Import/ Export files on page 49 for details.



System > Homepage layout

This section explains how to set up your own customized homepage layout.

General settings

This column shows the settings of your hompage layout. You can manually select the background and
font colors in Theme Options (the second tab on this page). The settings will be displayed automatically
in this Preview field. The following shows the homepage using the default settings:

General settings || Theme options

%VI\[@EK Mega-Pixel Network

e — ]
g e
-— -l
- ==
T—

Video stream | 1 Vl

# Manuzl triggers:

Digital output: | 0n | 09 |

n

[7] Hide Powered by VIVOTEK

— o OO P

m Hide Powered by VIVOTEK: If you check this item, it will be removed from the homepage.

Logo graph
Here you can change the logo that is placed at the top of your homepage.
Loge graph

Acustomized logo (Gif, JPG or PHNG) can be uploaded for main pade. twill be resized to
160x50 pixels to replace the previous logo.

" Default * Custom

- |— Browse... |
Y viverzk ]

Logo link: httpeifaeese vivotek.com

Follow the steps below to upload a new logo:

1. Click Custom and the Browse field will appear.

2. Select a logo from your files.

3. Click Upload to replace the existing logo with a new one.
4. Enter a website link if necessary.

5. Click Save to enable the settings.

Customized button
If you want to hide manual trigger buttons on the homepage, please uncheck this item. This item is
checked by default.

Customized button

V| Show manual trigger button




Theme Options

Here you can change the color of your homepage layout. There are three types of preset patterns for you
to choose from. The new layout will simultaneously appear in the Preview filed. Click Save to enable the

settings.

Font Color

3ackground Color of the
Control Area

Font Color of
the Configuration Area

ackground Color of the
onfiguration Area

Preset patterns

General settings | Theme options

WW, VW DT e, e

video stream | 1 [~

# Manuasl Uiggers:
Degital output: [ oe

PRI
- ]
S P ]
Themes Color
Font color: #000000
@ ) .
S | Font color of video fitle: -
Bk color of control area: #CAEAFF

Bk color of configuration area:

- Bk color of video area: H#CAEAFF
.
- Frame color:

Custom

Save

General settings || Theme options

Video stream

= Manual triggers:

Digital output:

General settings | Theme options

Video stream

Manual triggers: \ ‘a | .
Digital output: | - % ‘ .
- Eom r

mEMODPOAEPNE

ed by ¥ viversk

Font Color of the
Video Title

Background Color of
the Video Area

Frame Color



m Follow the steps below to set up the customed homepage:
1. Click Custom on the left column.
2. Click the field where you want to change the color on the right column.

Themes Color
Font color:
Font color of configuration area: EFFFFFF
_— g

Color Selector
Font color of video title:

Bk color of control area:
Bk color of configuration area:

[
[ ] Bk color of video area:

Custom s Custom Frame color:
Pattern

3. The palette window will pop up as shown below.

Hex: #000000 b
Red: 1]

Green: 0

Blue: 1]

Hue: 1] Hue: 212
Saturation: |0 Saturation: IE
Yalue: 1] Y alue: 4.1

4. Drag the slider bar and click on the left square to select a desired color.
5. The selected color will be displayed in the corresponding fields and in the Preview column.
6. Click Save to enable the settings.



System > Logs

This section explains how to configure the Network Camera to send the system log to a remote
server as backup.

Log server settings
Log server settings
¢+ Enable remoie log
IP Bddness:

port: 514

Save

Follow the steps below to set up the remote log:

1. Select Enable remote log.

2. In the IP address text box, enter the IP address of the remote server.
2. In the port text box, enter the port number of the remote server.

3. When completed, click Save to enable the setting.

You can configure the Network Camera to send the system log file to a remote server as a log backup.
Before utilizing this feature, it is suggested that the user install a log-recording tool to receive system log
messages from the Network Camera. An example is Kiwi Syslog Daemon. Visit http://www.kiwisyslog.
com/kiwi-syslog-daemon-overview/.
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System log

System log | Accass log

Jan 5 11:35.07 sysiogd 1.5.0: restan.

Jan § 11:35:08 [swatchdog]: Ready 1o watch hifpd.

Jan § 11.38.049 [EVERT MGR]. Slarting evenlmgr with suppon for EcTun

Jan § 11:35:11 [DRM Sendce]: Starting DRM sarvice.

Jan § 11:38:20 [UPAPIGDCP]: Search IGD falled

Jan § 11:35:23 adtomount(T18]: => mount: mourting /devimmcbiip on imntlauto/CF falled: Mo such
device or address !
Jan § 11:35:23 adtomount(T 18]: mountigeneric): faled o mount /devimmebkip1 (tpe viat)

on /mnt'arto/CF

Jan § 11:35:23 (IR Cut Control]: Day mode

Jan § 11:35:23 automount{T20): *> mount: mounting /devimmcbidp] on imntlaute'CF falled: Mo such
device or aodress

Jan & 11:38:23 automount{T28): mount|generic): faled 1o mount /devimmcbkip1 (type viat)

on imntante/'CF

Jan B 11:38:23 [IR Cut Condrol]: Day mode

Jan § 11:36:23 [5Y5): Seral number = 000ZD10E04CS

Jan B 11:38:23 [5Y5): System staris at'\Wed Jan 6 11:36:22 UTC 2011

This column displays the system log in a chronological order. The system log is stored in the Network
Camera’s buffer area and will be overwritten when reaching a certain limit.



You can install the included VAST recording software, which provides an Event
Management function group for delivering event messages via emails, GSM short

messages, onscreen event panel, or to trigger an alarm, etc. For more information, refer to
the VAST User Manual.

e @rlT o

VIVOTEK Network Cameras

S
3G Cell phone

@

S

Cell phone GSM
Short message

PC running Email
Modem ST7501 Recording Software

/7 N\
2] e B

Digital output
PTZ



Access log

System log

Jan 5 11:36:28 [RTSP SERVER)]: Start one session, IP=172.16.2.52
Jan 5 11:49:15 [RTSP SERVER]: Start one session, IP=192.168.4.105
Jan 5 13:11:20 [RTSP SERVER)]: Start one session, IP=192.168.4.105

Access log displays the access time and IP address of all viewers (including operators and
administrators) in a chronological order. The access log is stored in the Network Camera’s buffer
area and will be overwritten when reaching a certain limit.

System > Parameters

The View Parameters page lists the entire system’s parameters. If you need technical
assistance, please provide the information listed on this page.

Parameters

syastem hostname='FDE3IEBR-HVFZ' )
zyastem ledoff="0"

sya:em:lcw;ight='1‘

system date="Z016/07/06"

sy3tem time="11:08:20°

ayastem datetime='""

SFE:EHZﬁ:p="

syatem timezoneindex='"320'

system daylight enable='0"

zystem daylight dstactualmode='1"
SEE:EEZday;ight:au:c_heqintime='HOHE'
gyatem daylight auto endtime='NONE®

gyatem daylight timezones=',-360,-320,-280,-240,-241,-200,-201,-160
zyatem updateinterval="0"'

33?5:erf.:infr:n_:n-::de'_narr.e= '"FDE36BL-HVFZ'

gyatem info extendedmodelname='FDE3eBA-HVF2'

zygtem info serialnumber="'0002ZD1419364"
.3'-_;El:erf.:infr:n::'irrr.wareversin:".= '"FD336B-VVTK-0101a 4"
system info language count='"1l0'

system info language i0O='English'
ayatem info language il="Deutsch'
.3'-_:3:Erf.::i.nfcn:langl.:age:12= '"Ezpafiol’
system info language i3='Francgais'
system info language i4='Italiano'
system info language i5='HA:E"
system info language ié='Port ugueés"
system info lsnguags i7="@E{Fd "
system info language ig='%jfichir:
aystem info language i%='"Russian'
.33-'3:-21‘r.:infD:languag-a:il g='"
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System > Maintenance

This chapter explains how to restore the Network Camera to factory default, upgrade firmware
version, efc.

General settings > Upgrade firmware

Upgrade firmware

Select firmware file: Browse... | Upgrade |

This feature allows you to upgrade the firmware of your Network Camera. It takes a few minutes to
complete the process.
Note: Do not power off the Network Camera during the upgrade!

Follow the steps below to upgrade the firmware:

1. Download the latest firmware file from the VIVOTEK website. The file is in .pkg file format.

2. Click Browse... and locate the firmware file.

3. Click Upgrade. The Network Camera starts to upgrade and will reboot automatically when the upgrade
completes.

If the upgrade is successful, you will see “Reboot system now!! This connection will close”. After that, re-
access the Network Camera.

The following message is displayed when the upgrade has succeeded.

Reboot system now!!
This connection will close.

The following message is displayed when you have selected an incorrect firmware file.
4 N\
Starting firmware upgrade...

Do not power down the server during the upgrade.

The server will restart automatically after the upgrade is
completed.

This will take about 1 - 5 minutes.

Wrong PKG file format

Unpack fail

(. J

General settings > Reboot

Reboot

Reboot

This feature allows you to reboot the Network Camera, which takes about one minute to complete. When
completed, the live video page will be displayed in your browser. The following message will be displayed
during the reboot process.

The device is rebooting now. Your browser will reconnect to hitp:/192.168.5.151:80/

Ifthe connection fails, please manually enter the above IP address in your browser.

If the connection fails after rebooting, manually enter the IP address of the Network Camera in the
address field to resume the connection.



General settings > Restore
Restore

Restore all seflings to factory default except sefiings in

[ ] Metwork [ | Daylightsaving time [ | Custom language [ | VADP [ | Focus position

| Restore ‘

This feature allows you to restore the Network Camera to factory default settings.

Network: Select this option to retain the Network Type settings (please refer to Network Type on page
77).

Daylight Saving Time: Select this option to retain the Daylight Saving Time settings (please refer to
Import/Export files below on this page).

Custom Language: Select this option to retain the Custom Language settings.

VADP: Retain the VADP modules (3rd-party software stored on the SD card) and related settings.

Focus position: (Remote focus models only) Retain the lens focus position using the previously saved
position parameters.

If none of the options is selected, all settings will be restored to factory default. The following message is
displayed during the restoring process.

The device is rebooting now. Your browser will reconnect to http:M192.168.5.151:80/
[fthe connection fails, please manually enter the above IP address in your browser.

Import/Export files

This feature allows you to Export / Update daylight saving time rules, custom language file, configuration
file, and server status report.

General settings | Import/Export files

Export files

Export daylight saving time configuration file Export

Export language file Export

Export configuration file Export

Export server status report Export

Upload files

Update daylight saving time rules: Browse.. | Upload
Update custom language file: Browse.. | Upload
Upload configuration file: Browse.. | Upload

Export daylight saving time configuration file: Click to set the start and end time of DST (Daylight Saving).

Follow the steps below to export:

1. In the Export files column, click Export to export the daylight saving time configuration file from the
Network Camera.

2. A file download dialog will pop up as shown below. Click Open to review the XML file or click Save to
store the file for editing.



File Download

&

Do you want to open or save this file?

Mame: config_dst.xml
Type: ¥ML Document, 11.1 KB
192,168.5.151

e

Framm:

J | J

Open Save Cancel

while files from the Internet can be useful, zome files can potentially
harm your computer. [F pou do not trust the zource, do not oper or

9

zave this file, What's the rigk?

3. Open the file with Microsoft® Notepad and locate your time zone; set the start and end time of DST.

When completed, save the file.

In the example below, DST begins each year at 2:00 a.m. on the second Sunday in March and ends at

2:00 a.m. on the first Sunday in November.

B config_dst - Motepad
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Update daylight saving time rules: Click Browse... and specify the XML file to update.

If the incorrect date and time are assigned, you will see the following warning message when uploading

the file to the Network Camera.

B conlij_ds1 - Matzpad
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The following message is displayed when attempting to upload an incorrect file format.

Microsoft Internet Exploren

L] E The file must hawve a .xml filename suffix,
L3

Lok |

Export language file: Click to export language strings. VIVOTEK provides nine languages: English,
Deutsch, Espariol, Frangais, Italiano, P # 3%, Portugués, fffked3z, and H48 ¢ < .

Update custom language file: Click Browse... and specify your own custom language file to upload.

Export configuration file: Click to export all parameters for the device and user-defined scripts.

Update configuration file: Click Browse... to update a configuration file. Please note that the model and
firmware version of the device should be the same as the configuration file. If you have set up a fixed IP
or other special settings for your device, it is not suggested to update a configuration file.

Export server staus report: Click to export the current server status report, such as time, logs,
parameters, process status, memory status, file system status, network status, kernel message ... and so
on.

-‘@’- Tips:

« If a firmware upgrade is accidentally disrupted, say, by a power outage, you still have a last resort
method to restore normal operation. See the following for how to bring the camera back to work:

Applicable scenario:

(a) Power disconnected during firmware upgrade.
(b) Unknown reason causing abnormal LED status, and a Restore cannot recover normal working
condition.

You can use the following methods to activate the camera with its backup firmware:

(a) Press and hold down the reset button for at least one minute.

(b) Power on the camera until the Red LED blinks rapidly.

(c) After boot up, the firmware should return to the previous version before the camera hanged. (The
procedure should take 5 to 10 minutes, longer than the normal boot-up process). When tthis
process is completed, the LED status should return to normal.



Media > Image

This section explains how to configure the image settings of the Network Camera. The
Focus window is available only for models that come with a motorized lens.

General settings | | Image settings | | Exposure | Focus || Privacy mask

General settings

Video settings

Video fitle

[] Show timestamp and video title in video and snapshots

Position of imestamp and video title on image: ITOIJ v

Timestamp and video fitle font-size: 30w
video font { tf): |Defau|t ﬂ Upload
Color: Oew ® color
Power line frequency: (50 Hz ®E0Hz
Video origntation: [ Aip [ Mirror
[] Rotate

Video title

Show_timestamp_and video_title in_video_and_snapshots: Enter a name that will be displayed on
the title bar of the live video as the picture shown below. A zoom indicator will be displayed on the
Home page when you zoom in/out on the live viewing window as shown below. You may zoom in/
out on the image by scrolling the mouse wheel inside the live viewing window, and the maximum
zoom in will be up to 4 times.

Video Title Video)TCP-Ay) 2014/7/09 17:08:56
Title and Time

Zoom Factor

"

ol[glm][e[s]w w[a

Position of timestamp and video title on image: Select to display time stamp and video title on the

top or at the bottom of the video stream.

Timestamp and video title font size: Select the font size for the time stamp and title.

Video font (.ttf): You can select a True Type font file for the display of textual messages on video.

Color: Select to display color or black/white video streams.

Power line frequency: Set the power line frequency consistent with local utility settings to eliminate
image flickering associated with fluorescent lights. Note that after the power line frequency is
changed, you must disconnect and reconnect the power cord of the Network Camera in order for
the new setting to take effect.




Video orientation: Flip - vertically reflect the display of the live video; Mirror - horizontally reflect the
display of the live video. Select both options if the Network Camera is installed upside-down (e.g.,
on the ceiling) to correct the image orientation. Please note that if you have preset locations, those
locations will be cleared after flip/mirror setting.

Rotate -
Normal Flip Mirror Rotate 90°
VRotate gg [+ Degrees nd =» L) sy
L] L] —
The rotation here indicates clockwise \/{ M
rotation. Rotation can be applied with
flip, mirror, and physical lens rotation L
(see below) settings to adapt to different ]
mounting locations. \/[(

The figures in the illustration are shown in
a consecutive order.

2N
[]

22 2h D

The camera may be installed on a vertical, side-facing, or tilted surface in order to accommodate
the interior or exterior design of a building. The interior of a building can be shaped as a narrow
rectangular space, such as corridor. The conventional HD image, such as that of a 16:9 aspect
ratio, will be incongruous with its wide horizontal view. With video rotation, the camera can more
readily cover the field of view on a tall and narrow scene.

Day/Night Settings

Switch to B/W in night mode
Select this to enable the Network Camera to automatically switch to Black/White during night
mode.

Turn on external IR illuminator in night mode
Select this to turn on the external IR illuminator when the camera detects low light condition and
enters the night mode. A Digital Output connection to external IR is needed.

Turn on built-in IR illuminator in night mode
Select this to turn on the camera’s onboard IR illuminator when the camera detects low light
condition and enters the night mode.




Smart IR
(IMPORTANT: Smart IR is available when the external/built-in IR option is enabled)

When enabled, the camera automatically adjust the IR projection to adjacent objects in order to
avoid over-exposure in the night mode.

The Smart IR function is more beneficial when the spot of intrusions or an object of your interest
is close to the lens and the IR lights. For example, if an intruder has a chance of getting near the
range of 3 meters, Smart IR can effectively reduce the over-exposure. For a surveillance area at a
greater distance, e.g., 5 meters or farther away, the Smart IR function may not bring as significant
benefits as in close range.

Smart IR disabled; distance: 5M Smart IR enabled; distance: 5M

Smart IR disabled; distance: 3M Smart IR enabled; distance: 3M




-‘@’- Tips:

If there is an object in close proximity, the IR lights
reflected back from it can mislead the Smart IR’s
calculation of light level. To solve this issue, you
can place an “Exposure Exclude” window on an
unavoidable object in the Exposure setting window.
See page 60 for how to do it.

You can also configure the “Exposure Exclude”
window in a night mode “Profile” setting so that your
day time setting is not affected.

=Profile ol exposure seltings

Add nibaia mndie Add sulliane wedaw

ACTvaing pediod
¥ | Exsie med azply i prefie i
Dy mede
® gl mede

Schedals mode

IR cut filter

With a removable IR-cut filter, this Network Camera can automatically remove the filter to let IR
light enter the light sensor during low light conditions.

m Auto mode
The Network Camera automatically removes the filter by judging the level of ambient light.

m Day mode
In day mode, the Network Camera switches on the IR cut filter at all times to block infrared light
from reaching the sensor so that the colors will not be distorted.

m Night mode
In night mode, the Network Camera switches off the IR cut filter at all times for the sensor to
accept infrared light, thus helping to improve low light sensitivity.

m Synchronize with digital input
The Network Camera automatically removes the IR cut filter when a Digital Input is triggerred.
For example, the digital input can come from a housing that is equipped with IR illumination and
control circuits such as VIVOTEK’s AE-241.



VIVOTEK

m Schedule mode
The Network Camera switches between day mode and night mode based on a specified
schedule. Enter the start and end time for day mode. Note that the time format is [hh:mm] and is
expressed in 24-hour clock time. By default, the start and end time of day mode are set to 07:00
and 18:00.

Light sensor sensitivity
Tune the responsiveness of the IR filter to lighting conditions as Low, Normal, or High.

When completed with the settings on this page, click Save to enable the settings.

56 - User's Manual




Image settings
On this page, you can tune the White balance and Image adjustment.

Canaral maifinge  Imapa asithps || Mepnara || Mo | | Priney mosk

Sensor Setting 2:
For special situations e

Sensor Setting 1:
For normal situations

s ¥ o

ot

Beiwis Ly

White balance: Adjust the value for the best color temperature.
m You may follow the steps below to adjust the white balance to the best color temperature.

1. Place a sheet of paper of white or cooler-color temperature color, such as blue, in front of the
lens, then allow the Network Camera to automatically adjust the color temperature.

2. Click the On button to Fix current value and confirm the setting while the white balance is being
measured.

m You may also manually tune the color temperature by pulling the RGain and BGain slide bars.

Image Adjustment
m Brightness: Adjust the image brightness level, which ranges from 0% to 100%.

m Contrast: Adjust the image contrast level, which ranges from 0% to 100%.

m Saturation: Adjust the image saturation level, which ranges from 0% to 100%.

m Sharpness: Adjust the image sharpness level, which ranges from 0% to 100%.

m Gamma curve: Adjust the image sharpness level, which ranges from 0 to 0.45.
You may let firmware Optimize your display or select a value to change the preferred level of
Gamma correction towards higher contrast or towards the higher luminance for detailed expression
for both dark and lighted areas of an image.

Defog: Defog helps improve the visibility quality of captured image in poor weather conditions such
as smog, fog, or smoke.



Noise reduction

m Enable noise reduction: Check to enable noise reduction in order to reduce noises and flickers
in image. This applies to the onboard 3D Noise Reduction feature. Use the pull-down menu to
adjust the reduction strength. Note that applying this function to the video channel will consume
system computing power.

3D Noise Reduction is mostly applied in low-light conditions. When enabled in a low-light
condition with fast moving objects, trails of after-images may occur. You may then select a lower
strength level or disable the function.

Note that the Preview button has been cancelled, all changes made to image settings is directly
shown on screen. You can click Restore to recall the original settings without incorporating the
changes. When completed with the settings on this page, click Save to enable the setting. You
can also click on Profile mode to adjust all settings above in a tabbed window for special lighting
conditions.

Normal light mode | | Profile mode

Enable to apply these setings at ~

(O] Might mode () Schedule mode

Enable to apply these settings at: Select the mode this profile to apply to: Day mode, Night mode, or
Schedule mode. Please manually enter a range of time if you choose Schedule mode. Then check
Save to take effect.




Exposure

On this page, you can configure the Exposure measurement window, Exposure level, Exposure
mode, Exposure time, Gain control, and Day/Night mode settings. You can configure two sets of
Exposure settings: one for normal situations, the other for special situations, such as the day/night/

schedule mode.

Gencrol setlings | bnape setlings | | Crpowme | Privecy mask

B2 b E3 10

Sensor Setting 2: Harmal bght mode | Profike mods

For special situations
Measurement window A
) Full view Cusbom BLL

Exposure control

Exposure ievel

| Flickerless
Sensor Sett":]g 1 :_ Exposure time. ' ¥ 132000 - 130
For normal situations

Gain coriol 5 L) 0-100%

AE speed adjustmen

LY
Eratib: AF spemed acasimim|

Restore I| save

Measurement Window: This function allows users to set measurement window(s) for low light
compensation. For example, where low-light objects are posed against an extremely bright
background. You may want to exclude the bright sunlight shining through a building's corridor.

m Full view: Calculate the full range of view and offer appropriate light compensation.

m Custom: This option allows you to manually add customized windows as inclusive or exclusive
regions. A total of 10 windows can be configured. Please refer to the next page for detailed

illustration.



The inclusive window refers to the “weighed window*®; the exclusive window refers to “ignored
window". It adopts the weighed averages methodology to calculate the value. The inclusive
windows have a higher priority. You can overlap these windows, and, if you place an exclusive
window within a larger inclusive window, the exclusive part of the overlapped windows will
be deducted from the inclusive window. An exposure value will then be calculated out of the
remaining of the inclusive window.

Include X
Include = Weighted region

Exclude X

Ignored region

Exclude

m BLC (Back Light Compensation): This option will automatically add a “weighted region® in the
middle of the window and give the necessary light compensation.

Exposure control:

m Exposure level: You can manually set the Exposure level, which ranges from -2.0 to +2.0 (dark
to bright). You can click and drag the semi-circular pointers on the Exposure time and Gain
control slide bars to specify a range of shutter time and Gain control values within which the
camera can automatically tune to an optimal imaging result. You may prefer a shorter shutter
time to better capture moving objects, while a faster shutter reduces light and needs to be
compensated by the electrical brightness gains.

m Exposure mode:

When the Manual mode is selected, you can click and drag the semi-circular pointers on the
Exposure time and Gain control slide bars to specify a range of shutter time and Gain control
values within which the camera can automaticallly tune to an optimal imaging result. You can
also configure the iris size to control the amount of light. For example, you may prefer a shorter
shutter time to better capture moving objects, while a faster shutter reduces light and needs to be
compensated by electrical brightness gains.

- Flickerless:
Fixed iris models can encounter image rolling band issues when operating under incongrous

power line frequency with fluorescent lights. To solve the problem, the Flickerless mode can limit
the exposure time to 1/120 ~ 1/5 second. For the Auto iris models, when the exposure time is
limited to 1/120 ~1/5 second, iris size is automatically adjusted, and that the image brightness
is appropriately adjusted. Although the chance is rare, for Fixed iris models, when the exposure
time is limited to 1/120 ~ 1/5 second, they may encounter image over-exposure. If the Flickerless
option is selected, and users discover over-exposure from the live view, they can disable the
Flickerless option.



Auto: If you set Exposure mode as Auto, the Exposure time and Gain control will not be
configurable since the sensor library will automatically adjust the value according to the ambient
light. Then you can configure iris mode as “indoor” or “outdoor” to reach the best image quality.

m Iris mode: Select Indoor or Outdoor iris mode to adapt to the installation. The preset iris aperture
setting will apply. Note that on a fixed lens model, this option is not configurable.

m AE Speed Adjustment:

This function applies when you need to monitor fast changing lighting conditions. For example,
the camera may need to monitor a highway lane or entrance of a parking area at night where
cars passing by with their lights on can bring fast changes in light levels. The same applies if
the camera is installed on a vehicle, and when it needs to adapts to fast changes of light when
entering and leaving a tunnel.

= WDR:

This refers to the Wide Dynamic Range function that enables the camera to capture
details in a high contrast environment. Use the checkbox to enable the function, and
use the slide bar to select the strength of the WDR Pro functionality, depending on the
lighting condition at the installation site. You can select a higher effect when the contrast
is high (between the shaded area and the light behind the objects).



You can click Restore to recall the original settings without incorporating the changes. When
completed with the settings on this page, click Save to enable the settings.

If you want to configure another sensor setting for day/night/schedule mode, please click Profile to
open the Profile of exposure settings page as shown below.

Activated period: Select the mode this profile to apply to: Day mode, Night mode, or Schedule
mode. Please manually enter a range of time if you choose Schedule mode. Then click Save for the
configuration to take effect.

Cweral aatiegs Bhage welegn  lopovary | Rool  Privacy mask

Please follow the steps below to set up a profile:

1. Select the Profile mode tab.

2. Select the applicable mode: Night mode or
Schedule mode. Please manually enter a
range of time if you choose Schedule mode.

3. Configure Exposure control setting